Data Analysis & Business Intelligence Made Easy with Excel Power Tools
Excel Data Analysis Basics = E-DAB

Notes for Video:
E-DAB 10: Excel & Power Bl Together
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1) Different Versions of Power Bl (Different Power Bl Products) Available from Microsoft :
1) Microsoft web site link for Power Bl Products:
https://powerbi.microsoft.com/en-us/pricing/

2) Versions of Power Bl (Different Power Bl Products):
i. Power Bl Desktop
1. Price: Free
Connect to hundreds of data sources
Clean and prepare data using visual tools
Analyze and build reports with custom visualizations
Publish to the powerbi.com

oUW

7. Create Web Embed Code you can post at Public web site.
ii. Power Bl Pro
1. $9.99, per user, per month
Build dashboards that deliver a 360-degree, real-time view of the business
Keep data up-to-date automatically, including on-premises sources
Collaborate on shared data
Audit and govern how data is accessed and used
Package content and distribute to users with apps
Publish to powerbi.com and have others view on any device.

O NOU R WN

Measures will not download into an Excel file).
iii. Power Bl Premium
1. Price: Negotiated per node, per month

Allocate, control, and manage your dedicated server capacity

vk wnN

reporting
6. Deploy in the geographic region of your choice

2) Download Power Bl Desktop :

Can share “.pbix” file so others with the “free” Power Bl Desktop can view.

From published report viewers can download Data Model into Excel or as a “.pbix” file. (Implicit

Share data with users inside and outside your organization without purchasing a per-user license

Unlock higher limits for Pro users with datasets up to 10 GB and refresh up to 48 times per day
Access interactive and paginated reports online or use Power Bl Report Server for on-premises

i. Microsoft Download Page: https://www.microsoft.com/en-us/download/details.aspx?id=45331

1. When you want to update each month, you have to re-download and re-install.

ii. Microsoft Windows Store: https://powerbi.microsoft.com/en-us/desktop/
1. This download will automatically update each month.
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3) Difference between Power Bl Desktop and Power Bl Online (powerbi.com) :
1. Power Bl Desktop
1.Free Download
2.We can import data and create data model.
3.We can import full Data Model and Power Query Queries from an Excel Workbook.
4.We can create reports with visuals on tabs (pages).
5.We can use the file to analyze or email the “pbix” file to someone else who has Power B
Desktop.
6.We can publish Report to Power Bl Online (powerbi.com).
2. Power BI File “.pbix”:
1.Report = Power Bl file:
i. Created with Power Bl Desktop
ii. Contains:
e The Tabs (Pages)
e The Data Model connected to the Columnar Database.
2.Data Model contains:
i. Tables that are stored in Columnar Database.
ii. Relationships between tables.
iii. DAX Formulas.
iv. Hierarchies.
3.Tab (Page) in Power BI File = A Page with a set of visuals.
3. Power Bl Online (powerbi.com)
1.Free Version or paid version, like Power Bl Pro.
2.We can import Data Sets (Data Models) from:
i. A Power Bl Desktop “pbix” file
ii. An Excel File.
3.We can import Power Bl Desktop Files “.pbix” files and all the Tabs with visuals.
4.We can Import an Excel file to view the Excel Worksheet Tabs with Excel Online.
5.We can create Workspaces that can hold: Dashboards, Reports, Excel Workbooks and Data
Sets (Data Models).
4) Power Bl Online (powerbi.com): Dashboards, Reports, Excel Workbooks and Data Sets :
1. We can create Workspaces that can hold: Dashboards, Reports, Excel Workbooks and Data Sets
(Data Models).
2. Hereis a description of each:
1. Workspace = collection of Dashboards, Reports, Workbooks and Data Sets for a specified
set of people (e-mail addresses).
2. Dashboard = a place to pin Pages (Tabs) from a Power Bl Report, Excel Worksheets from
an Excel Workbook, or individual visuals from either a Power Bl Report or an Excel
Worksheet.
3. Reports = list of published “.pbix” files.
4. Workbooks = published Excel Workbooks that we can view in Excel Online.
5. Data Set in Power Bl Report = a single Data Model.
i. Each Power Bl Report is connected to One Data Set.
ii. Each Excel Workbook is connected to one Data Set.
iii. Dashboards can be connected to Tabs from different Reports and Excel Workbooks
and thus different Data Sets.
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5) Send Excel Power Pivot Data Model & Power Queries to Power Bl Desktop :

1. Hereis a picture of the Data Model in the Excel Workbook named “E-DAB-10-
ExcelFileWithDataAndReports.xlsx”:

2 dDate
1 Date

T Year
71 Month Number

1 Month

4 %4 Date Hierarchy

Year (Year)
Month (Month)

2. Hereis a picture of the Queries created with Power Query in the Excel Workbook named “E-DAB-10-

= fsales
Date
Units
NetRevenueFactor
NetCostFactor
IDProduct
If3 Total Sales
12 Ave Transactional Sales
I8 Ave Daily Sales
I8 Running Total YTD
Ifa Total COGS
I8 GrossProfit %

ExcelFileWithDataAndReports.xlsx”:

Queries & Connections

Queries | Connections

5 gueries
0 fSales
510,298 rows loaded.
3 dSupplier
Connection only.
B dSubCategories
Connection only.
f dProducts
30 rows loaded.

f3 dCategory
Connection only.

v X

[ dProducts

{71 IDProduct
[ Product
[T Retail Price
[T Standard Cost
[T Supplier

[T Category

[T Sub Category

3. Toimport the Power Pivot Data Model and the Power Query Queries, open the Power Bl Desktop
file with the name “E-DAB-10-PowerBIDesktop-Start.pbix’, go to the File menu, then hover over the
Import option, then click on the “Power Pivot, Power Query, Power View” button, as seen here:

|H | B4 © < = | E-DAB-10-PowerBIDesktop-Start - Power Bl Desktop
\;‘—’ New Import

Open

Power Query, Power Pivot, Power View

Gl Power Bl template

— |
=]

I[l Custom visual from file
P/’ Save As

D Get Data > L
r[j]\ Import >

Custom visual from marketplace

Cﬂ Export >
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4. Select the downloaded file “E-DAB-10-ExcelFileWithDataAndReports.xIsx”, then click Open, as seen

here:
sl Open X
T « D I ilesForEDAB10 > D il ilesForEDAB10 v 0 p el
Organize v New folder =~ [
A Name Date modified Type Si}
> Quick access
17| E-DAB-10-ExcelFileSourceTables.xlsx 26/19 12:59 PM Microsoft Excel W.
‘@ OneDrive '] E-DAB-10-ExcelFileWithDataAndReportsxlsx  3/26/19 8:22 PM Microsoft Excel W...
[ This PC
B 3D Objects
[ Desktop
|=] Documents
& Downloads
D Music
N v < >
File name: | E-DAB-10-ExcelFileWithDataAndReports.xlsx V‘ Excel files (*xlsx) L2

5. Click the “Start” button in the next dialog box, as seen here:

>
Import Excel workbook contents
We don't work directly with Excel workbooks, but we know how to extract
the useful content so you can work with it in Power Bl Desktop.
A new Power Bl file will be made for you. It will contain as much of your
content as possible. This could take a few minutes,
Learn more
Start Cancel
6. Inthe next window, click “Close” , as seen here:
X

Import Excel workbook contents
v/ Migration completed

Queries (6 items) A
fSales

dSupplier

dSubCategories

dProducts

dCategory

dDate

2 T T T

Data model tables (3 items)

Close

7. Note: Excel Files with the extension “.xIsm” can not be imported into a Power Bl Desktop File.
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6) Create Power Bl Visualizations based on Excel Data Model :
1. From the skills we learned last video, create a Power Bl Desktop Page, as seen here:

rrrrr

Y Filters VISUALIZATIONS FIELDS

display

7) Sign in to powerbi.com :
1. If you are a Highline College Matriculating Student, you can use your Highline User Name and
Password to log in.
2. If you are a YouTuber watching and learn about powerbi.com, you will need to sign up for a 60-day
free trial to use Power Bl at powerbi.com (as seen in video at 5:20 minute mark).
8) Create Workspace at powerbi.com :
1. Workspace = collection of Dashboards, Reports, Workbooks and Data Sets for a specified set of
people (e-mail addresses).
2. To create Workspace:
1. On the left click “Workspaces”.
2. Then click on Create App Workspace, as seen here

Home (praview) Q Search content...

Favorites
Dashboards Reports Work

Recent

NAME 1
Apps

L=
1] Click . Shared with me . My Workspace
Workspaces

= Workspaces Q. Search 2] Click
\ Create App

‘ My Workspace APP WORKSPACES Workspace

DASHBOARDS
All Togett

PowerQuery(4-Oakland.csv
TwoTabDashboard Create app wo «

REPORTS

o

GelBoomerangs
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Name the Workspace.

Create Privacy Settings.

Edit Privileges?

Add e-mails for people who can join workspace.
Click Save.

Nouks~Ww

Edit workspace

3] Name
Workspaces \ Nama
N
MSPTDA
4] Pri Privacy
rivac
Settings Public - Anyone can see what's inside
/ Members can edit Power Bl content
5] Edit v
Privileges? Workspace members

Enter email addresses

Add
excelisfun_gmail.com#ext#@highline... Member
mgirvin@highline.edu Admin

Advanced

Delete workspace Save

Cancel

6] Add e-mails for
people who can
join workspace

7] Save
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9) Different Sections of a Workspace :

1. After selecting a Workspace, on the left of Power Bl Online (powerbi.com), you can see the four
sections: Dashboards (pinned tabs and visuals), Reports Power Bl Reports), Workbook (Excel
Workbooks), Data Sets (Data Models from Excel and Power Bl Desktop), as seen here:

% GelBoomerangs

DASHBOARDS
E-Dab-10

REPORTS
E-DAB-10-PowerBIDesktop-Start

ExcelDataSetReport

WORKBOOKS
E-DAB-10-ExcelFileWithDataAndReports

DATASETS
E-DAB-10-PowerBlDesktop-Start

2. After click on a Workspace on the left side of Power Bl Online (powerbi.com), in the middle of Power
Bl Online (powerbi.com), you can see the four sections, as seen below:

Power BI % | GelBoomerangs

Home (preview) Q Search content...

Favorites

Dashboards Reports Workbooks Datasets ataflows (preview)

Recent
NAME 1 ACTIONS
Apps
E-DAB-10-ExcelFileWithDataAndReports it O 5 =5
Shared with me
E E-DAB-10-PowerBIDesktop-Start e O 5 <
Workspaces

GelBoomerangs

DASHBOARDS

E-Dab-10 Dashboards (pinned tabs and visuals)

oA 10 PowerBiDeskop S Reports Power Bl Reports)

Bieeliataheluepa Workbook (Excel Workbooks)

DA A0 Exce e otaArRepors Data Sets (Data Models from Excel and Power Bl Desktop)

DATASETS
E-DAB-10-PowerBIDesktop-Start

DATAFLOW:
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10) Publish Power Bl Desktop Report (Power BI File “.pbix”) to Power Bl Online (powerbi.com) :
1. Inthe Power Bl Desktop file (“.pbix” fiIe) use the, as seen here:

| New Measure [_]
=5 e

Lj New Column
Manage : Publish
Relationships Lz New Quick Measur

Relationships Calculations Share

2. Inthe next dialog box, select the Workspace that you want to publish the Report to and then click
“Select”, as seen here:

Publish to Power BI

Select a destination

Select Cancel

3. Inthe next dialog box you can click the link to jump to Power Bl Online (powerbi.com), as seen here:

X

Publishing to Power Bl

v/ Success!
ESS
<‘Open 'E-DAB-10-PowerBlDesktop-Finished.pbix' in Power Bl >

Get Quick insights

. Did you know?
lllﬂ

You can create a portrait view of your report tailored for mobile phones
on the View tab select Phone Layout. Learn more

Gotit
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11) Share Report with others so that they can view on any device :
1. With your Power Bl Report showing at Power Bl Online (powerbi.com), in the upper right corner,

click the Share button, as seen here:

S| & | | ?

=g Viewrelated Yy Favorite [=1 Subscribe

2. Below is the Share Window:

Share report
E-DAB-10-POWERBIDESKTOF

Share  Access

Only users with Power BI Pro will have access to this report. Recipients will have 1] E-mails for peOple you
the same access as you unless row-level security on the dataset further restricts 4 want to share Report.
them. Learn more

Grant access to

L~ 2] E-mail message.

3] Send E-mail

~ Allow recipients to share your report
~ Send email notification to recipients

[[] share report with current filters and slicers

You can also e-mail Report Link so they can view.

A

Report Link ©

https://app.powerbi.com/groups/ec2ebd422-b524-4572-891b-59897f78d9b2/rep:

// 4] Share button
Cancel
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12) Publish Excel file to Workspace (Worksheet Reports and Data Model) :
1. In Excel go to File Menu.
2. Then click on Publish.
3. Select Workspace.
4. In the Publish to Power Bl window select one of these options:
1. Upload your workbook to Power BI
i. You can't edit your workbook when open in Power BI.

_ ii. When you upload, the Data Model is uploaded.
1] File Menu iii. Your workbook will appear in Reports.

iv. Choose this option if want to see your worksheets, PivotTables and Charts at Power
Bl Online (powerbi.com) web site using Excel Online.
2. Export workbook data to Power Bl
i. The Excel Power Pivot Data Model is exported into a new dataset in Power BI.
ii. If you have any Power View sheets, those will be re-created in Power Bl as reports.
iii. You can then build a new Power Bl Report in the Power Bl Online Edit mode.

017-DashBoardAndPublishExcel xlsx - Excel

Publish

3] Select Workspace

Publish to Power Bl

Use Power Bl to create and share rich visual reports and dashboards from your wo,

nll Publish to Power Bl

ook. Learn more

You're signed in to Power Bl as MGirvin@highline.edu. Use another ac

Select where you'd like to publish to in Power B:

Gel Boomerangs v | Refresh
\
Upload your workbook to Power Bl
% ®  |nteract with your Excel workbook just as you would in Excel Online.
% 2
2] Publ |Sh Upload Pin selections from your workbook to Power Bl dashboards. 4] 2 Ways
= Share your workbook or selected elements through Power BI. P b I . h
@ This workbook was already uploaded to Power Bl. You can upload it again to replace = to ublish:
the workbook in Power BI.
) Export workbook data to Power BI
Publish D> = Export table data and data model into a Power Bl dataset.
®  Create Power Bl reports and dashboards from your dataset.
Close Export
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13) Create Power Bl Report based on Excel Data Set at the web site powerbi.com :
1. At powerbi.com (Power Bl Online), we can use the same tools we had in Power Bl Desktop to create

Reports.
2. In Data Set View, click the “Create Report” button, as seen here:

Dashboards Reports Workbooks Datasets Dataflows (preview)

NAME 4 ACTIONS

E-DAB-10-ExcelFileWithDataAndReports / O 4

“Create Report” button

db

T
R

d O

2]
|

E-DAB-10-PowerBIDesktop-Start

14) Dashboards at Power Bl Online (powerbi.com) :
1. We use the word “Dashboard” all the time to refer to collections of visualizations that we create on

an Excel Worksheet or on a Power Bl Report Tab (Page). But in Power Bl Online (powerbi.com) it has

a slightly different meaning.
2. At Power Bl Online (powerbi.com), a Dashboard is a collection of Excel Worksheets, Power Bl Report

Tabs (Page), or individual visualizations that we pin to a Dashboard.
3. To pin an item from a Power Bl Report to a Dashboard, use the “Pin Live Page” Button:

H Power Bl % GelBoomerangs > ExcelDataSetReport

File v  View v  Edit report ‘ ) Refreh ﬁ Pin Live Page

Home (preview)

)
if{ Favorites

MAKE A SELECTION TO PIN

You can pin ranges from your Excel workbook to Power
Bl dashboards. Make a selection in the gnd and click the
pin icon to start pinning.
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15) MSPTDA is next class! :

1. After you complete the E-DAB Class (Basic Excel Data Analysis and Power Bl), you can move on to
the MSPTDA Class (Advanced Excel Data Analysis and Power Bl).
2. Hereis the class link:

https://www.youtube.com/playlist?list=PLrRPvpgDmwOks5W7U5NmDCU2ydSnNZA 1

3. Hereis a screen shot of the 19 videos that hav been posted so far for the MSPTDA Class:

© Advanced Data Analysis. Microsc X =+

< c 0

8 https:;//www.youtube.com/playlis

= [ Youlube

Microsoft Power Tools for Data Analysis

Class Introduction Video

Power Query [
Power Pivot

Advanced Data Analysis.
Microsoft Power Tools for Data
Analysis (MSPTDA): Power
Query, Power Pivot, DAX, Power 4
Bl. MSPTDA Playlist of Videos.

22 videos *+ 45,989 views * Last updated on Feb 24,
2019

= A

Playlist of Videos for this Free YouTube Class
BI 348 — Microsoft Power Tools for Data Analysis:

« Data Models, Reports, Dashboards and Analytics
Taught by Mike excelisfun Girvin, Excel MVP 2013-

data model, and building reports and dashboards to
provide insightful and actionable information.

MSPTDA Playlist
MSPTDA Playlist of Videos
Microsoft Power Tools for Data Analysis Playlist

DAX Formulas —_

%

ist=PLrRPvpgDmwOks5SW7USNmDCU2ydSnNZA_1

Search Q

Microsoft Power Tools for Data Analysis: Dashboards & Reports. Class Introduction Video. MSPTDA #01.

ExcellsFun

MSPTDA #02: Data Analysis Business Intelligence Terms: Microsoft Power Tools for Data Analysis Class

Power Bl Desktop 2 ExcellsFun
P PLAYALL
weiumn  MSPTDA 03: Power Query Introduction: Importing & Transformation Data in Excel & Power Bl Desktop
3 '_I-H ExcellsFun

“  MSPTDA 04: Power Query: Import Multiple Excel Files & Combine (Append) into Proper Data Set

[ ]
Powes Query Grows By
ar

ExcellsFun

MSPTDA 06: Power Query: Merge, Append, & UnPivot - 3 Important Transformations

+ Power Query 6 ExcellsFun

* Power Pivot

* DAX

* Power BI Desktop o

« Excel # o w» MSPTDA 07: Power Query: 6 Types of Joins, 6 Types of Merges: 9 Examples
For Creating; 7 ExcellsFun

2018
- A class about connecting to multiple source of data MSPTDA 08: Power Query Group By feature & Table.Group Function (5 Examples)
transforming the data into a refreshable & dynamic 8 ExcellsFun

MSPTDA 08.5: Power Query Group By Unique List or Consecutive Occurrences

ExcellsFun

Continues on next page:
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https://www.youtube.com/playlist?list=PLrRPvpgDmw0ks5W7U5NmDCU2ydSnNZA_1

o ey 1 e eeaics MISPTDA 09 Power Query Complete M Code Introduction: Values, let, Lookup, Functions, Parameters, More
T

ExcellsFun

Formula.Firewall Error in Power Query & Power BI: Rebuild This Data Combination Solved (MSPTDA 9.5)

ExcellsFun

v MSPTDA 10: Power Bl M Code for Moving Annual Total (MAT): Custom Function Power Query Custom Column

[PAAT 50 >

i Coge
12 [MoshBProdst ) ¢esom Coumn
Quisem Fusciion

ExcellsFun

(P ower Ouery)
** 57703 10|

import SOL Data

: - MSPTDA 11: Power Query to Import from SQL Server Database in Excel or Power Bl Desktop

e cucr,
13 % m ExcellsFun

an

LN 19:11

{ “mmrerwm 3 MSPTDA 12: Using Locale in Power Query Power Bl: Import & Append Text Files from Different Countries

e
T '3

15 [::] “ ExcellsFun

MSPTDA 13: Power Pivot Introduction #1: Relationships rather than VLOOKUP for PivotTable Report

* Regorn

MSPTDA 14: Power Pivot Into #2: Amazing Columnar Database Importing Millions of Rows Data into Excel

ExcellsFun

MSPTDA 15: Comprehensive Introduction to Excel Power Pivot, DAX Formulas and DAX Functions

ExcellsFun

Powrer B Desktop MSPTDA 16: Power Bl Desktop Comprehensive Introduction: Power Query, DAX, Dashboards, Publishing

—_— 2 ExcellsFun

rowerBlonline ~ MSPTDA 17: Power Bl Online: Dashbhoards, Reports, Excel Workbooks, Data Sets.

Dushbcandy, Aeports, Weckasoks, Duts Sety

20 G0« | [E| ExcelisFun

MSPTDA 18: DAX lterators, Table Functions, Grain, Cardinality, Materializing Tables Excel & Power BI

ExcellsFun
DAX L
il 1:07:00

MSPTDA 19: CALCULATE DAX Function & Filter Context & ALLSELECTED & KEEPFILTERS (50 Examples)

Filter

Context
22 AU P S ExcellsFun
o Ex
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